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Understanding Charting Fundamentals 
reating charts in Microsoft Office applications such as Excel, Word, and PowerPoint is 
an effective means of helping readers of financial statements and similar reports to 
understand the true meaning of the data presented in such statements and reports. Of 

course, this can only occur if the creator of the chart understands the fundamentals of building 
charts in Microsoft Office applications. In this chapter, we examine these fundamentals so that 
course participants have the fundamental knowledge to create Microsoft Office charts. 

Learning Objectives 
Upon completing this chapter, participants should be able to: 

• Identify the importance of communicating visually; 
 

• List key issues to consider prior to building a chart; 
 

• Describe the different types of charts available in Microsoft Office and which type of 
chart is appropriate in specific situations; 
 

• Identify the elements in a Microsoft Office chart and describe how to modify each; and 
 

• Create and edit basic charts in Microsoft Office. 

Why Communicating Visually is Important 
Stated simply, charts assist in communication by transforming large quantities of numerical data 
into easily understandable visual graphics. With charts, we convert seemingly endless ranges of 
rows and columns of data into smaller, more compact, and, presumably, more readily 
understood graphic objects. In doing so, we make it easier for the consumers of this information 
to identify the important data points, trends, results, deviations, etc. that the data contain. 

For example, suppose you have data that shows the number of customers served in a fast-food 
restaurant by hour. You wish to use this data to help you or a co-worker plan for adequate 
staffing of the restaurant during peak periods of demand. Figure 1 presents the 280 data points 
in a traditional tabular format – one that causes many readers’ eyes to gloss over. 

C 
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Figure 1 - Average Customers per Half-Hour for a Fast Food Restaurant 

However, charting the data in Figure 1 as a PivotChart allows the consumer of information who 
may not be numerically oriented to visualize quickly and easily the peaks and valleys of 
customer activity during a specific day and to plan staffing accordingly. Figure 2 presents an 
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example of such a PivotChart; the process of building such a chart is detailed beginning on page 
48. 

 

Figure 2 - Sample PivotChart Used to Understand Staffing Requirements 

From the example shown above, using charts to transform tabular ranges of data into meaningful 
and actionable information is a clearly a prime reason to use this tool. Another is the ability for 
a chart to generate new information that we can use in various situations such as budgeting and 
forecasting. For example, as shown in Figure 3, a trend line and regression equation could be 
added easily to a chart, allowing someone who is attempting to forecast next quarter’s sales to 
use the regression equation as the foundation of such a forecast. 
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Figure 3 - Chart with Regression Equation Added 

In sum, communicating visually through charts and other objects provides several significant 
advantages to those who choose to utilize this technique and know how to prepare meaningful 
charts. Among these benefits are: 

• Summarizing large quantities of data into single, compact objects; 
 

• Transforming tabular, numerical data into actionable information; 
 

• Providing self-service business intelligence by offering interactivity to end users, 
allowing them to self-select the data presented in the chart; and 
 

• Identifying trends in data and highlighting items requiring action and attention. 

Considerations to Make Prior to Building a Chart 
To achieve the benefits outlined above, consider carefully several important questions before 
building a chart. First, what is the objective of the chart? Eleven pre-defined chart groups exist 
in Microsoft Office, and the choices available in each of these groups are used for different 
purposes. So, for instance, if you are seeking to create a chart that shows trends in sales over 
time, you should use a different chart type than if you are seeking to compare the sales generated 
by each salesperson. 
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A second consideration is how the chart will be distributed to information consumers. Will the 
file containing the chart be available in a central location on a server or in the cloud? Or will 
you distribute the chart in another object, such as a PDF document? The answer to this question 
is important because it potentially limits some options such as interactivity. 

A third consideration is that of the choice of colors you will use in a chart. As a rule, the choice 
of colors should create stark contrasts in the different data series plotted on the chart. This is 
necessary so that consumers can clearly see the distinction in the data series, particularly if the 
chart is printed on a black-and-white printer, or if it is displayed in a presentation under less-
than-ideal lighting conditions. An associated issue is that of red-green color blindness. 
Recognizing that this condition afflicts between 7% and 10% of the male population, avoid 
using these two colors on the same chart as they may be indistinguishable by information 
consumers with this condition. 

The type and source of the data that you wish to plot in a chart is a fourth critical consideration. 
If, for example, you will keypunch the data directly into an Excel spreadsheet and then chart 
that data, you have much greater control over the resulting chart. On the other hand, if you will 
extract the data from another database and attempt to build the chart on the extracted data, you 
may find it necessary to manipulate the data before constructing the chart. Likewise, if your 
chart needs to allow for end-user interactivity, then your approach to constructing the chart will 
be altogether different than if you merely need to create a “one-off” line chart. 

Types of Charts Available in Microsoft Office 
Before proceeding with discussion on how to customize charts and manipulate chart data, a 
review of the basic chart types is in order. Microsoft Office includes seventy-three predefined 
chart types in eleven broad categories. The following table summarizes the types and number 
of charts available in Office. 

• Column – 19 

• Line – 7 

• Pie – 6 

• Bar – 15 

• Area – 6 

• XY – 5 

• Stock – 4 

• Surface – 4 

• Doughnut – 2 

• Bubble – 2 

• Radar – 3 

Column charts, the most common of all chart types, display data points in vertical columns. 
Column charts are typically used to compare discrete values and do not necessarily imply the 
passage of time. A bar chart is very similar to a column chart, except that a bar chart has a 
horizontal orientation, while a column chart has a vertical orientation. Bar charts are useful in 
comparing a large number of values and for when category labels are lengthy. Cylinder, cone, 
and pyramid charts are variants of column and bar charts in Office. 

Line charts are used commonly to plot continuous data over time. Line charts are exceptionally 
useful in helping to identify trends in data. A line chart assumes that all of the data points plotted 
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are spaced evenly in time. An area chart is essentially a line chart where the area below the 
line has been filled. Like line charts, area charts are useful for displaying values over time.   

XY charts, or scatter plots, show the relationships between variables plotted on the X 
(horizontal) and Y (vertical) axes. The values plotted on the X-axis are independent of the values 
plotted on the Y-axis. In other words, the values plotted on the X-axis drive, or cause, the values 
plotted on the Y-axis. Bubble charts are like XY charts but with an additional data series 
represented by the size of the bubbles. Bubble charts are useful for representing data across three 
dimensions. 

Pie charts display the relative makeup of data. They are useful for identifying proportional 
values or contributions to a total. For pie charts to be effective, use no more than five or six data 
points. When you have a greater number of data points, consider using a bar chart, pie of pie 
chart, or bar of pie chart instead. A doughnut chart is similar to a pie chart except that it can 
display more than one series of data. However, because each successive series of data is placed 
in concentric rings, it can be relatively easy to misinterpret the meaning of the chart. Given this 
limitation, doughnut charts are usually best utilized with only one data series. If multiple series 
of data are required, consider using a stacked column chart instead. 

Radar charts have separate axes for each category of data.  These axes extend outward from 
the center of the chart. Radar charts are useful for identifying relationships among data series 
and in making comparisons of data values. With a surface chart, colors are used to distinguish 
values, not series. Surface charts can display two or more data series on a surface and are often 
used to find optimum combinations between two sets of data. 

Stock charts are very useful for displaying information regarding security prices such as high, 
low, or closing stock prices. In addition, opening values and volume may be displayed. Stock 
charts may also be used to display scientific data. For example, stock charts may be useful in 
charting rainfall or temperatures. 

Choosing the Right Chart Type 
With all of the choices available, sometimes the most difficult part of creating a chart is choosing 
which type is best for a given situation. A few guidelines may be helpful. 

• When comparing items to other items, column charts, bar charts, and cylinder, cone, 
and pyramid charts are generally the best choice. 

• When comparing data over time, line charts and area charts are usually superior to 
other options. 

• To make relative comparisons of one data point to another, pie and doughnut charts are 
useful.  Stacked bar charts, stacked column charts, 100% stacked bar charts, and 100% 
stacked column charts are also good choices.  

• Causal relationships in data are often best depicted with XY charts.  If three data values 
need to be plotted, use a bubble chart instead of an XY chart. 
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Elements of a Microsoft Office Chart 
Each Microsoft Office chart contains some or all of the elements listed below. If an element 
needs modification or adjustment for proper display, simply click on the element to activate it 
and then act on the element through the Ribbon or context menu. An alternative approach to 
selecting an element for modification is to do so through the Chart Tools Format contextual tab 
as shown in Figure 4. Using this approach, select the element you wish to modify and then click 
Format Selection on the same tab of the Ribbon. 

 

Figure 4 - Selecting a Chart Element for Editing 

Adjust the formatting, scaling, appearance, etc. as required and then move on to the next element 
that requires adjustment. While Excel does a good job of automating the entire charting process, 
advanced users can fine-tune charts by modifying individual elements. 

• Data Series – broad categories of 
data plotted in a chart 

• Data Points – individual data ele-
ments plotted in a chart 

• Category Axis – horizontal axis 

• Category Axis Label – labels along 
the category axis 

• Value Axis – vertical axis 

• Legend – identifies data series 

• Data Labels – identifies data points 

• Gridlines – used to visually extend 
labels from an axis 

• Chart Area – background area of a 
chart 

• Plot Area – section of a chart 
containing the actual plot, including 
the plotted data, the axes, and the axis 
labels 

• Walls – used for formatting the 
vertical axis in 3-D charts 

• Floor – used for formatting the 
horizontal axis in 3-D charts 

• Trendlines – can be plotted against 
data in a chart; can also be used to 
display a linear regression formula 

• Error Bars – display potential error 
amounts relative to each data marker 
in a data series 

• Chart Title – identifies the chart 

A very important point to stress is that you can format each element on a chart independently of 
every other element. This provides exceptional power when customizing a chart to meet your 
specific needs. For instance, you could select an entire data series and, for example, change the 
color of the data series in the chart. However, you could also select only one data point within 
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that data series and change just the color of that single data point. This power and flexibility 
means that you can customize a standard Microsoft Office chart to satisfy an almost unlimited 
number of needs.  

Creating Simple Charts in Microsoft Office 
While most accounting and financial professionals will choose to build their charts in Excel, it 
is important to understand that Microsoft Office 2007/2010 applications share numerous 
enhancements, including a unified charting tool. This is an important consideration because it 
means that you can build charts in various Office applications using a common methodology 
and workflow. 

Charting in Word 
It is a shock to many to learn that charting is a function found in Microsoft Word and that it has 
been present there for many versions. For instance, in Word 2003, you can create a chart in 
Word by choosing Insert, Picture, and Chart from the menu. As indicated previously, the 
charting engine in Word 2007 and higher is significantly improved compared to prior versions 
of Word. To create a chart, choose Chart from the Insert tab of the Ribbon to open the Insert 
Chart dialog box shown in Figure 5. For those who prefer keyboard shortcuts, ALT+N+C 
opens the Insert Chart dialog box in Word, PowerPoint, and Excel. Note that the Insert Chart 
dialog box is the same in all Office applications. 

 

Figure 5 - Insert Chart Dialog Box 

Select your desired Chart Type and click OK. Upon doing so, you will see that something 
interesting occurs. Word inserts the outline of a chart into the document, but it also 
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simultaneously opens an Excel worksheet in which you can add, edit, and delete the data for the 
chart as shown in Figure 6. 

 

Figure 6 - Creating a Chart in Microsoft Word 

Excel does not actually save the data that appears in the Excel editing grid as part of an Excel 
workbook; rather, Word saves that data as part of the XML-based Word 2007/2010 file. This is 
an important consideration because it means that data does not link to the Word document; 
instead, Word embeds it into the document. As such, it also means that if you send the Word 
document to another user, the other user will be able to edit the data for the graph.  

Charting in PowerPoint 
Because of the common charting tool residing in Office, the process for building a chart in 
PowerPoint is virtually identical to the process of building a chart in Word. Choose Insert and 
Chart from the Ribbon, select the desired Chart Type, and click OK. PowerPoint builds the 
basic chart and simultaneously opens an Excel grid for editing the data. As with Word, the data 
in the Excel grid saves as part of the PowerPoint file, not in a separate Excel workbook. 

Charting in Excel 
Since the early days of Lotus 1-2-3, professionals have relied on spreadsheet programs for the 
bulk of their charting needs. For accountants, this was particularly true for a very practical 
reason: most of the data that they needed to chart was already in a spreadsheet. Thus, it was 
natural to chart the data in the application that housed the data. 

Building a basic chart in Excel follows the same process as building basic charts in Word and 
PowerPoint with a few minor variations. If you choose to select the Insert tab of the Ribbon to 
create a chart, Excel prompts you in advance for the type of chart you wish to create. If you wish 
to see the Insert Chart dialog box and make your selection from there, click the dialog launcher 
for the Charts group. In either case, upon making a selection, if you did not select a data range 
before inserting the chart, Excel only inserts a placeholder for the chart on the worksheet. You 
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should then click Select Data from the Chart Tools Design contextual tab to select the data 
range you wish to include in the chart.   

If, on the other hand, you want to create a chart based on your default chart type, Excel provides 
two shortcuts for doing so. In both cases, first highlight the data range you wish to include in 
the chart. Then, if you want the chart to appear on the same worksheet, press ALT+ F1, and 
Excel will create a chart based on the selected data range and the default chart type. If you prefer 
for the chart to be on a separate worksheet, press F11, and Excel creates a new charting 
worksheet placing the chart as the only object on that worksheet. Note that while you may 
subsequently move that chart to another worksheet, Excel reserves the charting worksheet for 
charts only, and data may not reside on it. 

Creating and Editing a Chart in Excel – A Detailed 
Illustration 
Creating a chart in Excel requires four basics steps: 

1. Arranging the data in a way that makes it easy to chart, 
 

2. Selecting an appropriate chart type, 
 

3. Selecting a chart layout and style from the Chart Tools tab, and 
 

4. Fine-tuning the chart's look and feel on the Chart Tools Layout or Format tabs or by 
using a context-sensitive menu. 

 
Generally, arranging the data so that the X-axis categories are in columns, and the data series 
are on rows produces the best charts using the default process. While most users instinctively 
highlight their data before creating a chart, that step is unnecessary, unless you want to chart 
two or more noncontiguous data ranges. To select noncontiguous data ranges, use CTRL + 
Click and Drag to highlight the ranges. 
 
To create the first example chart, position the cursor within the data. Press ALT + F1 to create 
a chart as an object on the worksheet that contains the data and then reposition and resize the 
chart as desired. To resize a chart, first select the chart and then click on one or more of the eight 
resizing handles on its border indicated by the rectangles in Figure 7 and then drag them to 
resize the chart. 
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Figure 7 - Using the Chart Border to Resize and Reposition a Chart 

To reposition a chart, first select the chart and then click on its border, making sure to avoid the 
resizing handles. The cursor will change to a compass rose as shown in the circle in Figure 7 at 
which point the chart may be dragged to its desired position. After repositioning the chart, the 
worksheet should resemble the one in Figure 8. 
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Figure 8 - Simple Column Chart Created with a Single Keystroke 

 
To create a chart on a separate Chart Sheet, position the cursor within the data 
to be charted and press F11. Both one-click methods create a chart using the 
default chart type. To change the default chart type, click on a chart to display 
the Chart Tools tab. Select the Chart Tools, Design tab and then click 
Change Chart Type. In the Change Chart Type dialog box, select the 
desired default chart type, click Set as Default Chart, and click OK. 

 
Now that we have a chart, select Change Chart Type from the Chart Tools, Design contextual 
tab and review the various chart types available. In our example, a simple column chart is 
appropriate for our needs, but a chart's type can be changed at any stage of creation or use. Our 
chart needs a title and the Y-axis formatted so that it displays dollar signs and zero decimal 
places. To choose a layout that includes a chart title, select the Chart Tools, Design tab. Expand 
the Chart Layout gallery and select a layout that contains a chart title and a legend on the right 
hand side as shown in Figure 9. Note that the chart layout gallery will change, depending on 
the type of chart selected. 
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Figure 9 - Selecting a Chart Layout 

In the chart, click and highlight the text of the placeholder label Chart Title and type in DNM 
Marketing LLC. Press ENTER to continue on another line. Change the font to 12pt and then 
enter Sales by Division. Click anywhere on the chart to end the edit process. 

Now, let's change the number format of the quarterly sales amounts. Click anywhere on the 
numbers in the Y-axis area to activate the axis. A gray box will surround the area. Select the 
Charts Tools, Layout contextual tab. Click on Axes, Primary Vertical Axis, More Primary 
Vertical Axis Options to open the Format Axis dialog box. Click on Number in the 
Navigation Pane on the left. In the Number pane on the right, select Currency in the Category 
box, enter 0 decimals, and select $ as the symbol. Click Close to apply the changes. The process 
described is shown in Figure 10. 

To format a chart element, you can simply double-click the element you wish to format. As 
mentioned previously, you can also format an element by choosing it from the Chart Tools 
Format contextual tab of the Ribbon. Additionally, you can format an element of a chart by 
right-clicking the element and choosing the Format option from the resulting contextual menu. 
For example, to format the vertical axis of any chart, just right-click in the vertical axis area and 
select Format Axis. 
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Figure 10 - Changing the Number Format of the Y-Axis 

Now, let's make the chart more appealing by adding some visual effects. Click on the chart and 
select the Chart Tools, Design contextual tab.  Expand the Chart Styles gallery and select one 
of the new dark background styles, Style 42. Select the Chart Tools, Format contextual tab, 
expand the Shape Styles gallery, and click Colored Outline – Accent 2. Next, let us “dress-
up” the chart even more. Select Themes from the Page Layout tab and then click on the Apex 
theme to complete our chart. The process described, along with the completed chart, is shown 
in Figure 11. The process to create a simple chart with professional results could not be easier 
or faster. 
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Figure 11 - Adding Advanced Visual Effects to a Simple Chart with a Few Clicks 

Suppose that a quarter has passed, and the CFO of DNM Marketing would like to change the 
chart to include the latest quarter while removing the oldest quarter. First, type in the new 
heading (Q1) and data in the column immediately to the right and adjacent to the current data. 
Enter 112.2, 148.4, and 139.7 for the North, South, and East divisions, respectively. Now, click 
on the chart. In the source data, the legends are surrounded by a green box, the X-axis labels are 
surrounded by a magenta box, and the data series are surrounded by a blue box. Click and drag 
the blue box in the lower right-hand corner of the data series area one cell to the right so that the 
new quarter is now inside the box. Similarly, click and drag the blue box in the lower left-hand 
corner of the data series area one cell to the right so that the original first quarter data is not 
included in the data series box. Notice how the chart immediately changes to reflect the new 
data range. Figure 12 shows the completed chart. 
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Figure 12 - Adding Data and Adjusting the Data Range of an Existing Chart 

Manipulating Axes 
The next example is designed to demonstrate the ease with which users can switch axes and 
delete unwanted data series in a chart. Position the cursor in the chart data and press ALT + F1 
to create the initial chart. Resize and reposition the chart as desired. Change the chart layout so 
that the chart includes a chart title and a legend on the right. Note that the chart displays quarters 
as the legend elements and the product groups as the X-axis elements. Switch the axes so that 
the product groups become the legend elements, and the quarters become the X-axis elements. 
Click on the chart and select the Chart Tools, Design contextual tab. Now, click on Switch 
Row/Column in the Data group. The chart now displays quarters as the X-axis elements. 
Debbie, the owner of DNM Marketing, wants a chart to help her understand whether the new 
lotion line is cannibalizing the old crème line. Click on the chart columns for Mask, Astringent, 
and Scrub, in turn, and press DELETE to delete these three data series from the chart. The 
process described and the resulting chart is shown in Figure 13. 
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Figure 13 - Switching Axes and Deleting Data Series 

Building Effective Charts in Microsoft Office 
oving beyond basic charting capabilities, to communicate visually with charts, you 
will need to know how take advantage of several techniques for fine-tuning your 
charts so that they are truly effective. In this chapter, we review some of the 

techniques for creating charts that communicate your message more effectively than the basic 
charts described in the preceding chapter. 

Learning Objectives 
Upon completing this chapter, participants should be able to: 

• Modify default chart settings, including chart type, color scheme, and save custom chart 
templates; 
 

• Create charts from variable data ranges by using Tables and Dynamic Defined Names; 
 

• Build mixed charts that combine elements from multiple chart types; 
 

• Add dynamic text boxes to charts to explain the true meaning of the chart to information 
consumers; and 
 

• Apply conditional formatting to charts to highlight items requiring attention or action. 

M 
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Modifying Default Chart Settings 
Changing the Default Chart Type 
The default chart type in all Office applications is a traditional column chart. What if you find 
that you create few such charts and wish to change the default type to a line chart instead? 
Among the benefits of doing so would be one-click access to building charts in Excel using the 
F11 and ALT+F1 keystrokes discussed earlier. To change the default chart type, open the 
Insert Chart dialog box, click the type of chart you desire for the new default chart type, and 
click Set as Default Chart as shown in Figure 14. 

 

Figure 14 - Changing the Default Chart Type 

Upon making this change, whenever you use a keyboard shortcut to create a chart, the resulting 
chart will be your new default chart, allowing you quicker access to the type of chart you 
intended to create. 

Changing the Default Color Scheme 
Beginning with Office 2007, Microsoft introduced Themes into the Office suite. Themes are 
predefined groupings of colors and fonts. The default theme in each of the major Office 
applications is one entitled Office; the default theme controls the colors appearing in your 
charts. Of course, you can change these colors on a chart-by-chart basis. Alternatively, you can 
change your default theme to one of the other predefined themes, or you can create your own 
theme and make it the default setting. To change the default theme, you change your default 
template file – book.xltx for Excel, normal.dotx for Word, and blank.potx for PowerPoint – 
saving the desired theme in the template file. 
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Saving Custom Chart Templates 
Suppose you have spent a significant amount of time creating a specific chart design with 
multiple formatting attributes applied. You would like to save this chart as a template so that 
you can recall it and use it as the foundation for other charts in the future. To do so, simply save 
the chart as a new chart template. To save a chart as a template, select the chart and then click 
Save As Template from the Chart Tools, Design contextual tab. 

After saving the chart as a template, you can create new charts based on the template by 
choosing the Templates option from the Insert Chart dialog box shown in Figure 15. Of 
course, once you create a chart from a user-defined template, you can still “tweak” the formats 
of the various chart elements to achieve the desired look. 

 

Figure 15 - Inserting a Chart from a User-Defined Template 

Charting with Variable Data Ranges 
Tables 
Interactive charts are among the most highly sought-after forms of charts. In versions of Excel 
prior to 2007, users typically built interactive charts by creating dynamic defined names tied to 
form controls. End users changed the values in the form controls that caused the dynamic 
defined names to display different volumes or sets of data. While those techniques are still viable 
in Excel 2007 and Excel 2010, the advent of Tables provides an easier-to-implement solution 
in many cases. 

Tables are dynamically adjusting ranges of data. Because the definition of a table changes 
dynamically as the volume of data in the table changes, objects – including charts – that are built 
using tables as their data sources automatically change. This means that if you build a chart 
based on a table and later add more data to the table, the chart will automatically include the 
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new data; likewise, if you delete data from the table, the chart will contract. For example, the 
data in Figure 16 is a table named RegionalSales.  

 

Figure 16 - Table Data for a Chart 

Clicking inside the RegionalSales table and pressing ALT+F1 builds a chart in the default style 
based on the table. Now for the power of tables: as shown in Figure 17, adding the fourth quarter 
column to the table causes the chart to automatically add fourth quarter data without any manual 
intervention whatsoever! Likewise, if we apply filters to the table, the chart automatically filters 
as well. This, of course, only begs the question, “Why would we ever build charts based on 
traditional data ranges?” 
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Figure 17 - Adding Data to a Table Causing Charts Built Based on the Table to 
Expand Automatically 

Dynamic Defined Names 
A minority of Excel users are familiar with defined names. In the simplest of terms, defined 
names are simply nicknames for cells in an Excel worksheet and can be used in lieu of traditional 
row-and-column addresses throughout Excel. To illustrate, in the simple example shown in 
Figure 20, defined names were assigned to cells B5 and E3. The formula in cell B6 utilizes 
these defined names instead of the associated row-and-column addresses to create a self-
documenting formula.  
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Figure 18 - Example of Simple Defined Names Used in Formulas 

A second type of defined name is a dynamic defined name. A dynamic defined name is one 
created by a formula to provide for elasticity in the vertical dimension of the range, the 
horizontal dimension of the range, or both. In other words, similar to Tables, dynamic defined 
names can expand and contract vertically, horizontally, or both. 

Referring to Figure 19, the formulas encircled in the New Name dialog box creates the dynamic 
defined name “dynaSales” that begins in cell A1, is three columns wide, and extends vertically 
for as many non-blank rows as there are in column A. While an extended discussion of the 
OFFSET( ) formula is beyond the scope of this session, when used in this context, it essentially 
instructs Excel to start in a particular location and create a range that is x number of rows long 
and y number of columns wide. Because a formula creates the dynamic defined name, every 
time the formula recalculates, the definition of the range is subject to update. Thus, when users 
append or delete data, the workbook recalculates the ranges defined by the formula, and any 
objects that use these ranges as data sources – such as charts – also automatically update with 
additional data. 
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Figure 19 - Sample Dynamic Defined Name 

To begin to understand the concept of dynamic defined names in Excel-based charting 
environments, examine the data and the chart shown in Figure 20. In this example, the business 
owner would like the chart to update automatically whenever additional rows of data are 
appended to the range in columns A and B; in other words, we want this range to mimic a Table, 
discussed previously. 
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Figure 20 - Sample Chart Built Based on Dynamic Defined Name 

To accomplish this, create two dynamic defined names in the Name Manager on the Formulas 
tab of the Ribbon. The first, entitled DynamicSales, selects the data the chart is to plot. The 
actual formula used to create DynamicSales follows. 

=OFFSET($B$2,0,0,COUNTA($B:$B)-1,1) 

The second, entitled DynamicDate, selects the data to include on the horizontal axis. The 
formula used to create DynamicDate is shown below. 

=OFFSET($A$2,0,0,COUNTA($A:$A)-1,1) 

Once you have created the dynamic defined names, the rest is easy; insert a chart and specify 
the dynamic defined name for the series data and the dynamic defined name for the axis labels 
as shown in Figure 21. Note that in both cases, the name of the workbook prefaces the dynamic 
defined name; this is a requirement of using dynamic defined names as data sources for charts. 

 

Figure 21 - Creating a Chart Based on Dynamic Defined Names 

Adding Interactivity with Dynamic Defined Names 
The preceding discussion on building charts from dynamic defined names is not merely an 
academic one. Rather, dynamic defined names are a cornerstone of interactive charts in Excel– 
charts that allow users to self-select the data that appears. 
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The three following steps contain the basic workflow for creating interactive charts that use 
dynamic defined names.  

1. Create form controls with which the information consumer will interact. 
 

2. Create dynamic defined names for each data series and axis you will plot. These 
dynamic defined names will be partially affected by the data input from the form 
controls. 
 

3. Create and format the chart using the dynamic defined names as the data source. 

Form controls are useful for giving users control over the amount of data that is included in a 
chart. For example, it may be desirable in one instance to plot the latest twelve months of ending 
balances for accounts receivable and in another instance to plot only the last three months of 
data. Unlike creating charts that automatically update as the data expands or contracts, a scenario 
such as this is facilitated by controlling the size of the data range. 

With dynamic defined names, the data ranges automatically expand or contract as the volume 
of data changes. In this case, the data range expands and contracts based on user input. Form 
controls give the creator of a chart much greater control over the input of a chart user. In our 
example, a form control links to a cell that is an input to an OFFSET function. The OFFSET 
function controls the vertical size of the data range, which is a defined input to the chart. As a 
user manipulates the control, the size of the data range expands or contracts, and the chart 
changes to reflect the data range. Figure 22 shows a chart that uses a spinner form control to 
specify the number of months of data to display. 

 

Figure 22 - Chart Using a Spinner to Control the Chart Range 

Let us examine some of the steps to build a chart using a spinner to control the chart data range. 
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1. Enter the data in columns A and B as shown. Label the columns accordingly. 

2. Narrow column C for use as a spacer. Enter the label Number of Months to Display: 
in cell D1. Widen the column sufficiently so that the label fits within the cell borders. 

3. Now, create three defined names. 

a. The input range for the spinner control is easy. Place the cursor in cell E1 and 
then type Input in the Range box on the toolbars to create the defined name 
"Input." 

b. The dynamic defined names for the chart data range and X-axis range are a bit 
more difficult because they must be defined so that their size may be altered by 
the value in Input, the input cell for the spinner control. These defined names 
must be defined by formula, not cell references. 

i.In the New Names dialog box, type in ARBalance in the Names. In the 
Refers to box, enter the following formula and click OK. 

=OFFSET($B$3,0,0,Input,1) 

ii. Create another defined name for Months that refers to the following 
formula. 

=OFFSET($A$3,0,0,Input,1) 

4. Add and format the spinner form control. Locate the spinner just to the right of cell E1. 
Format the spinner with the values shown in Figure 23. 
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Figure 23 - Formatting the Spinner Form Control 

5. Create a new column chart in Excel. Add ARBalance as the range for the data series 
and Months as the range for the X or Horizontal axis, keeping in mind that the 
workbook name must be entered as part of the dynamic defined name. 

6. Enter Accounts Receivable Balance as the Chart Title. 

Finally, format, resize, and reposition the chart to complete the task of creating an interactive 
chart.  

Building Mixed Charts 
The next example uses a combination line and area chart on two axes to display quarterly sales 
dollars and gross margin percentage. Position the cursor in the data and press ALT + F1 to 
create the initial chart. Select the Chart Tools, Design tab and choose Change Chart Type. 
Select a line chart – Line with Markers-- and click OK. 

Immediately, you can see that the gross Margin Rate is hugging the X-axis because of the scale 
difference with sales dollars. The gross Margin Rate needs to be put on a Y-axis of its own. 
Click on one of the Margin Rate markers to activate the data series and then right-click and 
choose Format Data Series. Select Series Options in the Navigation Pane on the left and then 
click Secondary Axis in the Series Options pane on the right. Click Close. The new axis 
formatted as percentages appears on the right.  
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For better impact, sales dollars should to be plotted as an area chart. Click on one of the Sales 
markers. From the Chart Tools, Design tab, choose Change Chart Type. Select a simple Area 
chart and click OK. Immediately, the sales distribution fills solid to the X-axis, but the 
distribution does not extend to the Y-axes on the left and right. Click in the horizontal (X-axis) 
area to activate the axis. A gray box will appear around the axis area. Then, right-click and 
choose Format Axis. In the Navigation Pane, choose Axis Options. In the pane on the right, 
select Position Axis On tick marks and click Close. The partially completed chart is shown in 
Figure 24. 

 

Figure 24 - Partially Completed Line and Area Chart on Two Axes 

Now, choose a combination of chart layouts, chart styles, and themes to add the visual effects 
necessary to communicate your message effectively. When complete, the chart might resemble 
the one in Figure 25. 
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Figure 25 - Combination Line and Area Chart on Two Axes 

Adding Dynamic Text Labels to Charts 
While the concept of adding a text box to a chart to enhance a reader’s understanding of the 
chart sounds appealing, this could prove to be problematic from a practical standpoint because 
of the constantly changing nature of the data. What users really need is the ability to create text 
boxes that change based on changes in the underlying data. In other words, we need dynamic 
text boxes that provide analytical insight based on predefined criteria. Fortunately, creating 
dynamic text boxes in Excel charts is rather easy, as described below. 
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1. Create a chart based on the data in columns B and C below; a simple column chart 
similar to the one shown in Figure 26 will suffice.  
 

 

Figure 26 - Column Chart Displaying Sales Data by Product 

2. Next, create appropriate text strings providing the desired analytical messages. Excel’s 
TEXT( ), CONCATENATE( ), DOLLAR( ), and & functions are catalysts for such text 
strings. For example, consider the data pictured in Figure 27. 
 

 

Figure 27 - Data Used to Create Dynamic Text Boxes 
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• In cell A15, a formula was entered to create a text string displaying the average of 
all sales for the period; that formula, which contains a TEXT( ) function, is shown 
in Figure 28. 

 

 

Figure 28 - Formula for Displaying Average Sales 

• In cell A16, a formula has been entered to create a text string displaying the best 
selling item for the period; that formula, which uses two VLOOKUP( ) functions, 
is shown in Figure 29. 

 

Figure 29 - Formula for Displaying Best Selling Item 

• In cell A17, a formula has been entered to create a text string displaying the slowest 
selling item for the period; like the formula above, this formula also uses two 
VLOOKUP( ) functions and is shown in Figure 30. 

 

Figure 30 - Formula for Displaying Slowest Selling Item 

3. In the chart created in Step 1, insert a blank text box. With the text box selected, click 
in the formula bar and type the equals sign (=). Then, click in cell A15 so that the 
following formula is entered in the formula bar. 
 

 

Figure 31 - Formula for Entering Dynamic Text into Text Boxes 

Note that you must enter the formula directly into the formula bar and not into the text 
box. Also note that you must build the formula by clicking on the appropriate cells as 
described above; if you type the formula into the formula bar, it will not work correctly. 
Repeat this process for the other two formulas created above and align the text boxes as 
desired so that the chart resembles the one shown in Figure 32. 
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Figure 32 - Chart with Dynamic Text Boxes 

Applying Conditional Formatting on Charts 
Can we apply conditional formatting to charts? The short answer is “No, conditional formatting 
does not work on chart data.” The longer answer is “With a little creativity, we can trick 
PowerPoint into applying what appears to be conditional formatting.” 

Consider the data presented in Figure 33; sales data is presented for each of thirteen 
salespersons. You have been charged with the responsibility of creating a chart containing this 
data and also having the top-performing salesperson’s data as well as the bottom-performing 
salesperson’s data formatted differently than the rest of the data on the chart.  
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Figure 33 - Raw Data for Conditional Formatting on a Chart 

To accomplish this task, you will need to create three additional columns of data and plot those 
three columns of data – and not the original column of sales data – in a stacked column chart. 
The revised data should resemble that shown in Figure 34. 

 

Figure 34 - Revised Data for Conditional Formatting on a Chart 
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In cell C2 (and the remainder of the cells in the range extending through cell C14), the formula 
shown below is used to identify the maximum value in the range and to populate that value into 
the appropriate cell in Column C. 

=IF(B2=MAX(B$2:B$14),B2,0) 

The formula populates all other cells in Column C with zero. 

In cell D2 (and the remainder of the cells in the range extending through cell D14), the formula 
below was used to identify the minimum value in the range and to populate that value into the 
appropriate cell in Column D.  

=IF(B2=MIN(B$2:B$14),B2,0) 

The formula populates all other cells in Column D with zero. 

Finally, in cell E2 (and the remainder of the cells extending through cell E14), the formula 
given below was used to enter all values other than minimum and maximum values. 

=(B2-C2-D2) 

The formula populates the cells in column E corresponding to the rows that contain minimum 
and maximum values with zero. 

Once the data has been arranged as shown in Figure 34, a simple stacked column chart similar 
to the one shown in Figure 35 can easily be created. This chart consists of three data series: one 
for column C, one for column D, and one for column E. Each of these series is formatted 
differently than the others; column C is formatted in blue, column D is formatted in red, and 
column E is formatted in light yellow. Notice, however, that the zero values are effectively 
hidden from the chart because they are, in fact, zero values; thus, the chart gives the impression 
of applying conditional formatting to maximum and minimum values in column B. 
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Figure 35 - Chart with Conditional Formatting Applied 

Analyzing Data with Charts and Graphs 
mong the benefits associated with charting are the analytics and insights that are often 
provided by charts. In addition to built-in analytic tools, you can analyze data in Excel 
charts by using, among other techniques, histograms, Sparklines, and custom charts, as 

discussed in this chapter. 

Learning Objectives 
Upon completing this chapter, participants should be able to: 

• Create and use Trendlines to analyze data plotted in a chart; 
 

• Build histograms using Excel’s Data Analysis tools; 
 

• Work with Sparklines, a visualization tool added to Excel 2010;  
 

• Create Paired Column charts to assist with analyzing data; 
 

• Compare data between upper and lower boundaries using charts; and 
 

• Construct PivotCharts, perhaps the most powerful charting tool for analyzing data. 
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Using Trendlines for Analyzing Data 
Excel offers four chart elements for analysis – trendlines, error bars, drop lines, and up/down 
bars. These elements are briefly defined as follows. 

• Trendlines – Statistical trends fitted to data using least squares regression 

• Error bars – Used to show the standard error of an estimate 

• Drop lines – Vertical lines from data points to the x-axis so that users can ascertain the 
exact location of the data point on the x-axis 

• Up/down bars – Boxes drawn between two data series at each X-axis interval on a line 
chart to highlight differences 

Of these four tools, trendlines are perhaps most common. Suppose that Jill Harris, the CFO of 
GTM manufacturing, is trying to determine whether sales revenues for 2012 are reasonable in 
relation to sales revenues from prior years. Figure 36 presents summarized sales data for the 
company. Jill believes a chart with a trend line added will be the best way for her to confirm 
that sales are reasonable and in line with company trends. She also likes the visual impact that 
the chart will have in tomorrow’s Board of Directors meeting during which she will be called 
upon to brief the Board on GTM’s financial performance. 

 

Figure 36 – Summarized Sales Data 

To create the chart with a trend line, Jill begins by clicking in the data and choosing Line chart 
from the Insert tab of the Ribbon, followed by 2-D Line chart. She edits the data so that Year 
becomes the horizontal axis, and she deletes the Legend to create the chart shown in Figure 37. 
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Figure 37 - Initial Draft of Chart for GTM Manufacturing Sales Performance 

Next, Jill adds the trendline by right-clicking on the Sales line on the chart and choosing Add 
Trendline… from the pop-up menu. She accepts the default of a linear trendline and clicks OK 
to produce the chart shown in Figure 38. 

 

Figure 38 - Sales Chart with Trendline 

Based on the presence of the trendline on this chart and its very close proximity to the line for 
actual Sales revenue, Jill is comfortable with the reasonableness of the amount of recorded 
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revenue for 2012. She changes some of the chart’s formats so that the final product appears as 
shown in Figure 39. 

 

Figure 39 - Completed Sales Chart with Trendline 

Creating Histograms 
According to Merriam-Webster, a histogram is: 

a representation of a frequency distribution by means of rectangles whose 
widths represent class intervals and whose areas are proportional to the 
corresponding frequencies. 

Stated perhaps a bit more succinctly, a histogram is a column chart where the height of the 
columns represent the number of instances that a particular value or range of values occur. From 
the standpoint of accounting and financial professionals, histograms can be useful, for example, 
when attempting to analyze a large number of transactions such as cash disbursements to 
determine the most common disbursement amounts when conducting risk analysis in an internal 
or external audit. For instance, suppose you imported a list of cash disbursements into an Excel 
worksheet, similar to the extract shown in Figure 40.  
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Figure 40 - Extraction of Cash Disbursements Worksheet 

You would like to summarize the approximately 2,200 checks into four different “buckets” – 1) 
$0 to $100, 2) $100.01 to $500.00, 3) $500.01 to $1,000.00, and 4) over $1,000.00 – and upon 
doing so, express the results graphically. This is the type of analysis for which a histogram is 
well suited. 

To build a histogram, begin by enter your “bucket” ranges – formally known in Excel as “bin 
ranges” – anywhere on the worksheet as shown in Figure 41.  

 

Figure 41 - Adding Bin Ranges to Excel Worksheet 

Next, on the Data tab of the Ribbon, choose Data Analysis to open the Analysis Toolpak. 
Choose Histogram to open the Histogram dialog box. In the dialog box, enter the Input Range 
(the data you want to analyze), the Bin Range, and specify your Output options, specifically 
including Chart Output as shown in Figure 42. 
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 
If you do not see Data Analysis on the Data tab of the Ribbon, it is likely 
because the Analysis Toolpak has not been activated. You can activate the 
Analysis Toolpak by visiting the Add-ins section of Excel Options. 

 

 

Figure 42 - Histogram Dialog Box 

Upon clicking OK, Excel creates the histogram for you, an example of which is shown in 
Figure 43. 

 

Figure 43 - Completed Histogram 

Of note, the chart component of the histogram is like any other chart; that is, you can edit any 
element of the histogram to adapt it to your specific needs. For instance, Figure 44 contains a 
modified version of the basic histogram chart shown in Figure 43. The chart in Figure 44 has 
been modified to provide a bit more “curb appeal” than its predecessor. 
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Figure 44 - Edited Histogram 

Working with Sparklines 
Excel 2010 contains a new type of chart known as a Sparkline. Sparkline charts are simple one-
cell charts used to provide quick visual analysis of a data set. Typically, Sparklines forego most 
of the formatting characteristics otherwise applied to traditional charts; for instance, titles, axis 
labels, and legends are normally not present in Sparklines. 

Creating Sparklines is an easy process, even for those who otherwise have difficulty creating 
polished and professional-quality Excel charts. Simply highlight the data from which the 
Sparkline is to be created, choose Insert from the Ribbon, and select whether the Sparkline 
should be in the Line, Column, or Win/Loss format. For example, Figure 45 demonstrates 
creating the Line form Sparkline shown in cell H4 from the data residing in cells B4 through 
G4. 
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Figure 45 - Creating a Sparkline Chart in Excel 2010 

Users can create multiple Sparklines simultaneously. To do so, select multiple data ranges at the 
same time and multiple location ranges in the Create Sparklines dialog box as shown in Figure 
46. 

 

Figure 46 - Creating Multiple Sparklines Simultaneously 

Once created, clicking on a Sparkline activates the Sparkline Tools contextual tab on the 
Ribbon pictured in Figure 47. From this tab, users can edit and format a Sparkline or series of 
Sparklines. Examples of functionality accessible from this tab of the Ribbon include: 

• The ability to change the input data ranges for a Sparkline; 
• The ability to change the type of Sparkline; 
• Whether the Sparkline highlights specific data points – high, low, negative, first, last, 

and/or all; 
• The color of the Sparkline; and 
• Axis options. 
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Figure 47 - Sparkline Tools Contextual Tab 

When creating dashboards, Sparklines offer an opportunity to incorporate small, unobtrusive 
objects in an Excel workbook that provide visual enhancements to traditional column and row-
oriented data. 

Analyzing Data with Paired Column Charts 
Paired column charts mix clustered column charts with stacked column charts to allow an 
information consumer to see not only the relative mix of values within a particular product 
division, for instance, but also a comparison of one division to another. Figure 48 provides the 
data we would like to use in our paired column chart. With this chart, we would like to create a 
stacked column for the Retail – Brick and Mortar and Retail – Internet Sales data series and 
compare this stacked column to a traditional column for the Wholesale division.  

 

Figure 48 – Initial Data for Paired Column Chart 

To create the paired column chart, perform the following nine steps. 

1. Insert two placeholder data series into the data, including temporary data points that will 
later be changed to zeroes. Upon doing so, the revised data set should appear similar to 
that shown in Figure 49. 
 

 

Figure 49 - Revised Data for Paired Column Chart 

2. Create a stacked column chart for the data shown in Figure 49. If necessary, select 
Switch Row/Column option on the Design tab of the Ribbon so that the quarters are 
on the horizontal axis. 
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3. Right-click on the Wholesale data series, choose Format Data Series, and select the 
Plot Series On Secondary Axis option. Additionally, move both the Holder 1 and 
Holder 2 data series to the secondary axis, though you may have to do so by selecting 
them in the Current Selection group on the Chart Tools Layout contextual tab of the 
Ribbon. 
 

4. Right-click on the Holder 2 data series, choose Change Series Chart Type, and select 
a clustered column chart. 
 

5. Return to the data grid and set the values for the Holder 1 and Holder 2 data series to 
zeroes. 
 

6. Click on the secondary axis and press Delete. 
 

7. Right-click on the Wholesale data series, choose Format Data Series, and set the Gap 
Width option to 0%. 
 

8. Click the Legend; then execute a single click on Holder 1 to select just that entry. Upon 
doing so, press Delete. Repeat this process for the Holder 2 entry in the Legend. 
 

9. Lastly, modify the formatting of individual data elements on the chart to suit your 
particular needs. 

Upon completing the nine steps outlined above, your completed chart should resemble that 
shown in Figure 50. 

 

Figure 50 - Completed Paired Column Chart 
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Comparing Data between Upper and Lower Limits 
With a little creativity, we can use charts to help identify situations when data falls both inside 
and outside of established upper and lower boundaries. Suppose, for example, that you manage 
inventory for a small business, and you have been charged with keeping  the inventory 
investment within the boundaries shown in Figure 51 during the first six months of the year.  

 

Figure 51 - Established Targets for Inventory Investment 

You could build a chart similar to the one shown in Figure 52 to compare the actual investment 
to the targeted investment. 

 

Figure 52 - Chart Comparing Inventory Investment to Upper and Lower Limits 

To construct the chart shown in Figure 52, begin by constructing a worksheet similar to that 
shown in Figure 53. Notice in Row 11 of the lower half of the worksheet, a formula exists that 
subtracts the original lower limit from the original upper limit.  
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Figure 53 - Worksheet Used to Generate Actual versus Upper and Lower Limits Chart 

Upon constructing the worksheet shown above, create a stacked column chart that plots the 
Actual (row 9), Lower Limit (row 10), and Upper Limit (row 11) data for each of the six months. 
Your initial chart should look similar to that shown in Figure 54. 

 

Figure 54 - Initial Chart Comparing Actual versus Upper and Lower Limits 

On the initial chart, perform the following six steps to complete the process of creating the chart 
pictured in Figure 52. 

1. Right-click the Actuals data series, select Change Series Chart Type, and change the 
chart type to a line chart. Click OK. 
 

2. Right-click the Actuals data series again, choose Format Data Series, and choose Plot 
Series On Secondary Axis. Click Close. 
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3. Click on the newly created secondary axis on the right side of the chart and press Delete. 
 

4. Right-click on the Lower Limit data series, choose Format Data Series, Fill, and select 
the No Fill option. Click Close. 
 

5. Click on the Legend and press Delete. 
 

6. Add any additional desired formatting to the chart to complete the process. 

An alternative to this approach is to change the target ranges so that they are one continuous 
band of color across the chart instead of individual ranges for each month. To do this, right-click 
on any of the individual ranges, choose Format Data Series, and set the Gap Width option to 
0%. 

Introducing PivotCharts 
A PivotChart is a graphical representation of a PivotTable with all of the analytical power of the 
PivotTable. PivotCharts link inextricably to PivotTables so that changing the data or 
organization of one automatically changes the other. Because PivotCharts are just extensions of 
PivotTables, they are ideal tools for accountants and other business professionals to summarize 
large quantities of data and to present those summaries in an easy-to-understand graphical 
format. 

Users create PivotCharts in numerous ways; we will create our first PivotChart from a 
PivotTable. Assuming you already have access to a PivotTable, start by clicking in the 
PivotTable. Then, from the PivotTable Tools contextual tab Options, select PivotChart. 
Choose the chart type – columns, line, bar, etc. – and click OK to create a PivotChart similar to 
the one shown in Figure 55. 
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Figure 55 - Initial PivotChart 

Having created the initial PivotChart, a little cleanup is in order. Using some of the techniques 
discussed earlier in this course, we can transform the PivotChart into that shown in Figure 56. 

 

Figure 56 - Completed PivotChart Example 

In our second example of working with PivotCharts, John Ward needs to convert the data from 
his client’s Excel-based cash disbursements journal into a dashboard format the client can 
understand a bit better than a traditional row-and-column financial statement. John has already 
built a PivotTable to summarize the data; Figure 57 presents a copy of that PivotTable.  

$- $50,000.00 $100,000.00 $150,000.00 $200,000.00 $250,000.00 $300,000.00 
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1915G
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Figure 57 - Copy of PivotTable Used to Summarize Excel-based Cash Disbursements Journal 

To create a PivotChart from the PivotTable, John follows the process below. 

1. John positions the cursor in the PivotTable and selects PivotChart from the PivotTable 
Tools, Options contextual tab to open the Insert Chart dialog box as shown in Figure 
58. In the dialog box, John chooses a Stacked Column chart with 3-D effects. 

 

Figure 58 - Creating a PivotChart from a PivotTable 

2. When John clicks OK in the Insert Chart dialog box, Excel creates the chart and 
displays the first draft of it on the same worksheet as the PivotTable. Figure 59 shows 
that draft. 
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Figure 59 - First Draft of PivotChart 

3. John is not satisfied with the draft. Principally, he wants to swap the position of the rows 
and columns – that is, he wants to summarize the data by quarter rather than by account 
on the horizontal axis. Fortunately, this is an easy customization, and John accomplishes 
it by clicking on the Switch Row/Column icon on the PivotChart Tools, Design 
contextual tab. Additionally, John adds some additional formats so that the final chart 
resembles the one shown in Figure 60. 

 

Figure 60 - Completed PivotChart Summarizing Cash Disbursements Journal 
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Now John has an easy-to-read supplement to the traditional financial statement he prepared for 
this client. In building this PivotChart, John noticed several interesting features of PivotCharts. 

• A PivotChart inextricably links to its related PivotTable. If the PivotTable changes, so 
does the PivotChart; likewise, if the PivotChart changes, so does the PivotTable. This 
is advantageous because it ensures that the two objects always stay in sync. 
 

• PivotCharts contain on-screen filter buttons. For instance, referring to the PivotChart 
shown in Figure 60, John could choose to filter the Accounts the PivotChart displays by 
clicking the drop-down arrow next to Account to open the filter pane as shown in Figure 
61. 
 

 

Figure 61 - Filtering a PivotChart in Excel 2010 

Note that applying a filter to a PivotChart will change the related PivotTable as 
described above. Additionally, if John does not desire on-screen filtering capability, he 
can right-click on the button and choose the appropriate “hide” option from the pop-up 
menu. 
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• From a formatting perspective, a PivotChart is just like any other chart. In other words, 

all traditional formatting options are available. Thus, John can choose to format his chart 
using the same tools and options he would use if this were a “traditional” Excel chart. 
 

PivotCharts are truly one of Excel’s least known and least used tools, but one that offers 
tremendous power and flexibility to those who learn how to work with them. 

 Handling Special Charting Considerations 
hile Microsoft Office provides over seventy types of predefined charts, there may 
be occasions when the specific chart type you desire is not one of the “canned” charts 
available in Office. In these cases, you will need to build your custom chart by 

modifying a basic Office chart type. In this chapter, we present techniques for doing so. 

Learning Objectives 
Upon completing this chapter, participants should be able to: 

• Create Thermometer charts from simple column charts; 
 

• Build Gauge charts from pie charts and Tachometer charts from doughnut charts; 
 

• Construct Bullet charts from column and line charts; 
 

• Generate Waterfall charts from stacked column charts; 
 

• Use macros to create drill-down charts; and 
 

• Work with SmartArt to build objects such as Organizational Charts. 

Thermometer Charts 
Thermometer charts indicate progress made toward reaching a goal, such as progress toward 
sales goals or fund-raising goals. Although Microsoft Office does not directly support 
thermometer charts, they are easy to create as a variant of a common column chart. 

To create a thermometer chart like the one shown in Figure 62, create a column chart based on 
a single data point. Here are some tips for successfully creating a thermometer chart. 

1. Be sure that the data point has a blank row above and below. Otherwise, your Office 
application may attempt to plot additional points. 

W 
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2. If the chart is to show relative percentages, modify the Y-axis so that the Minimum and 
Maximum values on the Scale tab are set to 0 and 1, respectively. Adjust any other 
scaling option to meet your needs. 

3. Format the Data Series and set the Gap width to 0 on the Options tab so that the 
column uses the entire width of the plot area.  

4. Modify the X-axis to set Tick Mark Labels to None on the Patterns tab. 

 

Figure 62 - Thermometer Chart 

Upon completing the four steps outlined above, you should end up with a chart that resembles 
the one pictured in Figure 62. 

Gauge and Tachometer Charts 
Gauge Charts 
Gauge charts are popular for showing one number as a percentage of a total and are used 
increasingly in digital dashboards. Gauge charts, shown in Figure 63, are not a standard chart 
type in Microsoft Office, but they can be constructed relatively easily from a standard pie chart. 
The trick is to plot the data in 50% of the chart space. To create a gauge chart like the one shown 
in Figure 63, perform the following steps. 

1. Plot exactly three data points in a standard pie chart. 
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a. The first data point in the series must be set to 50% (or to one-half of the total 
of the three points if the points are not expressed as percentages). 
 

b. The second data point should be set to one-half of the desired plot value. In other 
words, if you want the gauge chart to appear to plot 80% as the second data 
point, set the value of the second point equal to one-half of that amount or 40%. 
 

c. The third data point should be a plug value such that the sum of the three data 
points is 100%. 

2. Hide the 50% data point. To do this, double-click on the 50% section of the chart and 
then right-click and choose Format Data Point. On the Fill tab, select No Fill and on 
the Border Color tab, select No line. 

3. On the Series Options tab, set the Angle of the first slice to 90 degrees. 

 

Figure 63 - Gauge Chart 

Tachometer Charts 
Tachometer charts such as the one displayed in Figure 64 are similar to gauge charts because 
they show a relative measurement of one value to the total. Tachometer charts also frequently 
include some qualitative measurements such as poor, average, or excellent. 

To build a tachometer chart using Microsoft Office, plot two data series on one doughnut chart. 
Both data series must contain a value of 50%, and the section of both doughnuts related to this 
value will be hidden just as in the gauge chart. The inner doughnut will be used to display a 
needle that points against the qualitative measurements shown in the outer doughnut. The needle 
is nothing more than the border between two data points that are formatted with the same color. 
The qualitative measurements are simply the category names plotted using the Label Options 
tab of the Format Data Labels dialog box. 



5 6  C O P Y R I G H T  ©  2 0 1 9 .  R E P R O D U C T I O N  O R  R E U S E  F O R  P U R P O S E S  
O T H E R  T H A N  A  K 2  E N T E R P R I S E S  T R A I N I N G  E V E N T  I S  P R O H I B I T E D  

 

Figure 64 - Tachometer Chart 

Bullet Charts 
A bullet chart is a type of chart that allows information consumers to see multiple layers of 
information simultaneously. Figure 65 presents an example of a bullet graph used to compare 
year-to-date results to year-to-date quota and to annual quota. This type of three-way 
comparison could be cumbersome for other types of charts. 

 

Figure 65 - Sample Bullet Graph Comparing YTD Results to YTD Quota and to Annual Quota 

  



C H A P T E R  4  

Figure 66 contains the data from which we will build a bullet chart.  

 

Figure 66 - Data for Bullet Chart 

To build the chart, perform the following nine steps. 

1. Create a stacked column chart from the data in Figure 66. Your initial chart should 
resemble that shown in Figure 67. 
 

 

Figure 67 - Initial Chart for Bullet Chart 

2. Right-click on the Annual Quota data series, choose Format Data Series, and select 
the option to Plot Series On Secondary Axis. Click OK. 
 

3. Right-click on the Annual Quota data series, choose Change Series Chart Type, and 
select Line Chart with Markers. Click OK. 
 

4. Right-click on the Annual Quota data series, choose Format Data Series, set Marker 
Options to Built-in, select the underscore character, and change the size to 15. 
Additionally, click Line Color and select the No line option. Click Close. 
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5. Right-click on the YTD Sales data series, choose Format Data Series, and select the 
option to Plot Series on Secondary Axis. Additionally, change the Gap Width option 
to 175%. Click Close. 
 

6. Right-click on the YTD Quota data series, choose Format Data Series, and change the 
Gap Width option to 75%. Click Close. 
 

7. Click on the secondary axis and press Delete. 
 

8. Right-click on the legend, choose Format Legend, and select Bottom for the Legend 
Position. 
 

9. Add any additional desired formatting to the chart to complete the process. 

Waterfall Charts 
Waterfall charts are useful because they help to “tell a story” or explain how we get from point 
A to point B. For example, the waterfall chart shown in Figure 68 explains how an 
organization’s gross revenue of $50,000 was consumed when arriving at net income of $4,000 
for a period. 

 

Figure 68 - Sample Waterfall Chart 

Like many other useful charts, a waterfall chart is not a standard chart in Microsoft Office; yet, 
you can easily construct one by creating a stacked column chart and then hiding one of the data 
series. Consider the following data set. 
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Gross Revenue         50,000  

Labor         24,000  

Discounts         10,000  

Advertising            6,000  

Overhead            4,000  

Travel            2,000  

Net Income            4,000  
 

To build a waterfall chart from this data set, begin by inserting a stacked column chart onto your 
slide, page, or worksheet. Next, in the resulting data grid, insert a column between the two 
columns shown above and add column headers above the two columns as shown below. 

 
Invisible Visible 

Gross Revenue 
 

        50,000  

Labor 
 

        24,000  

Discounts 
 

        10,000  

Advertising 
 

           6,000  

Overhead 
 

           4,000  

Travel 
 

           2,000  

Net Income 
 

           4,000  

 

In the column labeled “Invisible,” enter “0” for Gross Revenue and Net Income. In the column 
labeled “Invisible” for the “Labor” row, enter a formula that subtracts the amount from the 
“Visible” column for “Labor” from the amount for the “Visible” column for “Gross Revenue,” 
e.g., “C2 - C3.” Copy that formula down the range so that your data appears as shown below. 

 
Invisible Visible 

Gross Revenue 0          50,000  

Labor 26,000          24,000  

Discounts 14,000          10,000  

Advertising 4,000            6,000  

Overhead 2,000            4,000  

Travel 2,000            2,000  

Net Income 0            4,000  
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Upon doing so, right-click on the data series in the chart that displays the “Invisible” data and 
format that series so that there is “no fill.” Continue formatting the chart as desired to complete 
your waterfall chart. 

Drill-Down Charts 
Excel-based dashboard designers would often like to provide users with the ability to drill down 
on a chart, exposing additional data and details. Unfortunately, Excel does not natively provide 
such functionality. However, as with applying conditional formatting on charts, with a little 
creativity and trickery, we can add this level of functionality to our dashboards. 

For example, a sales manager of an organization might wish to see a year-to-date bar chart of 
sales. The manager might also wish to drill down on that chart to see additional details such as 
a year-to-date sales trend chart. As shown in Figure 69 and as described below, dashboard 
designers can add buttons to charts to facilitate this drill-down capability. To each button, the 
designer will attach a simple macro that toggles the view back and forth between the desired 
charts. 

 

Figure 69 - Drilling Down on One Chart Causing Another Chart to Appear 
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 To add such functionality to your dashboard, follow these five steps. 

1. Begin by creating two charts of exactly the same size. If necessary, you can adjust the 
size of a chart by selecting the chart and modifying the height and width of the chart on 
the Chart Tools Format contextual tab as shown in Figure 70.  
 

 

Figure 70 - Adjusting the Size of a Chart 

2. Next, assign names to both of the charts. To assign a name to a chart, select the chart 
and, on the Chart Tools Layout contextual tab, enter the desired name in the Chart 
Name box as shown in Figure 71. 
 

 

Figure 71 - Naming a Chart 

3. Add the macro shown in Figure 72 to the Excel workbook. When writing the macro, 
substitute the names of your charts for the references to “S1C1” and “S1C2” in the 
example. Also, substitute the name of your dashboard worksheet for the references to 
“Dashboard” in the example. Upon adding the macro, save your workbook as a macro-
enabled workbook. 
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Figure 72 - Macro to Enable Drill Down on Charts 

4. Add and format text boxes containing “Click here to…” instructions to each chart. 
Assign the macro added in step 3 to each of the text boxes by right-clicking on the text 
box and selecting Assign Macro. 
 

5. Finally, position the charts so that one of the charts is stacked directly on top of another. 
You can do this by clicking and dragging the charts to the desired location. You can also 
use Excel’s Nudge commands to fine-tune the position of the charts. 

Upon completing these steps, you will have two charts stacked one on top of another. The chart 
at the bottom of the stack will be invisible to the dashboard user. However, upon clicking a 
button on the top chart, the chart on the bottom of the stack will rise to the top, and the chart on 
the top of the stack will recede to the bottom – an incredibly powerful tool for increasing the 
usability of your dashboard charts. 



Using SmartArt in Microsoft Office Applications 
Creating a SmartArt Graphic 
Office 2007 introduced into Word, Excel, Outlook, and PowerPoint a new feature entitled 
SmartArt. SmartArt allows you to create presentation-quality graphics to communicate your 
message more effectively. SmartArt makes it easy to create business diagrams quickly and with 
a professional look. SmartArt layouts range from lists to organization charts to step-by-step 
processes. Some SmartArt shapes have special placeholders for inserting pictures. 

To create a SmartArt graphic, click the SmartArt icon from the Insert tab of the Ribbon as 
shown in Figure 73.  In the SmartArt Graphic dialog box, choose the graphic to create. The 
graphic names appear when moving the mouse pointer, and each shows a description for its use.  

 

Figure 73 – Creating a SmartArt Graphic 

Upon selecting the type of SmartArt graphic you wish to create, simply type the desired text 
into the SmartArt template; alternatively, you type the text into the SmartArt Text Pane that 
adjoins the graphic template. If the Text Pane does not appear, you can activate it on the 
SmartArt Tools Design contextual tab of the Ribbon. Notice that as you add text, the font size 
in all of the individual elements of the graphic adjusts automatically.  Figure 74 presents a 
completed example of a SmartArt graphic. 
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Figure 74 – Example of SmartArt’s Table List 

To edit the image to change colors, SmartArt styles, the layout, or any formatting option, click 
on the graphic and then choose the appropriate option either from the SmartArt Tools, Design 
or the SmartArt Tools, Layout contextual tab, both shown in Figure 75. 

 

Figure 75 - SmartArt Tools Design and Format Contextual Tabs 

Different Types of SmartArt 
Office 2007 and Office 2010 provide seven broad categories of SmartArt. Each of these 
categories and its primary function is described below. 

1. List. Lists are typically used to show text-based information that is not sequential, or 
when the order of the information presented is not necessarily important. SmartArt List 
objects are excellent alternatives to standard bullet points in a PowerPoint presentation. 
  

2. Process. If the arrangement of data is sequential, then typically SmartArt Process 
objects are a good choice. Process objects diagram the flow of data from one item, task, 
workflow, etc. to another. 
 

Growth

Inventory Sales Investment
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3. Cycle. Similar to Process objects, SmartArt Cycle objects illustrate a business process 
or workflow but show it in a repetitive or recursive fashion. Accordingly, these objects 
should be used when there is a continuing sequence of data. 
 

4. Hierarchy. As their name implies, SmartArt Hierarchy objects are used to display 
hierarchical relationships of data. These are typically used to create objects such as 
organization charts and tournament rosters because they can show relationships 
vertically or horizontally. 
 

5. Relationship. SmartArt Relationship objects generally present how individual parts 
relate to the whole, such as in a Venn diagram or an equation. These objects can also 
depict competing and counterbalancing ideas. 
 

6. Matrix. Similar to Relationship objects, a SmartArt Matrix object shows the 
relationship of individual components to the whole. The primary difference between a 
Matrix object and a Relationship object is that Matrix objects are depicted in quadrants. 
 

7. Pyramid. SmartArt Pyramid objects also show relationships of data but, in doing so, 
imply that some items are greater in importance, number, or stature than others. 

Customizing SmartArt Objects 
Adding Shapes 
Once you have created a SmartArt object, you can customize the object to meet your specific 
needs. For example, suppose you created the Table List object pictured in Figure 74 and 
subsequently discovered that you needed to add a fourth item in the series of Inventory, Sales, 
and Investment. To do this, you will need to add an additional rectangle to the SmartArt object, 
and that can be accomplished in two different ways. 

First, you could simply type the text for the fourth element directly into the Text Pane. Doing 
so will cause the Office application in which you are working to automatically add the fourth 
rectangle as shown in Figure 76. 
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Figure 76 - Changing a SmartArt Object through the Text Pane 

The second approach to adding a rectangle to the image would be to manually insert it into the 
object. To do so, right-click on the rectangle you want the new rectangle to immediately precede 
or follow and, from the resulting pop-up menu, choose Add Shape and then indicate whether 
you want the new shape added before or after the currently selected shape as shown in Figure 
77.  
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Figure 77 - Manually Adding a Shape to a SmartArt Object 

Promoting, Demoting, and Repositioning Text 
Another way of customizing a SmartArt object is to promote, demote, and reposition text in the 
Text Pane. Doing so causes the SmartArt object to update. For example, having added 
“Advertisement” to the object in Figure 76, see the impact on the object when the text is right-
clicked, and the Demote option is selected as shown in Figure 78. Upon demoting the text, it is 
placed in the same text box as “Investment” and becomes a bullet point in that text box. To 
restore “Advertisement” to its original text box, right-click on the phrase in the Text Pane and 
choose Promote. 



6 8  C O P Y R I G H T  ©  2 0 1 9 .  R E P R O D U C T I O N  O R  R E U S E  F O R  P U R P O S E S  
O T H E R  T H A N  A  K 2  E N T E R P R I S E S  T R A I N I N G  E V E N T  I S  P R O H I B I T E D  

 

Figure 78 - Demoting Text in SmartArt 

Likewise, text can be reordered and, in doing so, the arrangement of the SmartArt object will 
update also. Perhaps the easiest way to reorder text is to do so by cutting and pasting within the 
Text Pane. Alternatively, you can click and drag text boxes in the SmartArt object to reposition 
the objects and the text within them. If you choose this method, be sure to take advantage of 
your applications “Nudge” feature to ensure that the visual integrity of the object remains intact. 

Organizational Charts 
One of the strengths of SmartArt is its capability to assist you in creating organizational charts 
that allow for quick and easy modification. To begin this process, choose SmartArt from the 
Insert tab of the Ribbon, SmartArt, and in the Choose a SmartArt Graphic dialog box, select 
the Organization Chart object. Upon doing so, you should have a blank chart that appears as 
shown in Figure 79. 
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Figure 79 - Blank SmartArt Organization Chart 

Next, in the Text Pane, enter the names of the team members to be included in the organization 
chart so that your chart resembles the one shown in Figure 80. 

 

Figure 80 – Sample SmartArt Organization Chart 
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To add additional team members, simply add their names in the Text Pane and use the Promote 
and Demote functions discussed earlier to indicate their relative level in the organization. Notice 
that the modified chart in Figure 81 includes additional subordinate positions reporting to 
Bentley Harris and George Washington. 

 

Figure 81 - Organization Chart with Additional Subordinate Team Members 

To change the visual presentation of the organizational chart so that it is more horizontally 
oriented, perform the following three steps. 

1. Either on the chart or in the Text Pane, click on the name of the particular supervisor 
for whom you want to change the layout. 
 

2. On the SmartArt Tools Design contextual tab, click Layout in the Create Graphic 
group. 
 

3. Choose from the options of Standard, Both, Left Hanging, or Right Hanging.   

The organization chart presented in Figure 82 uses the Standard layout in contrast to the Right 
Hanging layout employed by the organization chart presented in Figure 80. 
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Figure 82 - Revised Organization Chart Using Standard Layout 

Lastly, to add an Assistant to an individual in the organization chart, perform the following 
steps. 

1. Select the individual to whom the Assistant will report and then choose Add Shape 
from the Create Graphic group on the SmartArt Tools Design contextual tab. 
Alternatively, right-click on the individual’s name on the organization chart and choose 
Add Shape from the pop-up menu.  
 

2. From the five options presented – Add Shape After, Add Shape Before, Add Shape 
Above, Add Shape Below, and Add Assistant – choose Add Assistant. 
 

3. Enter the Assistant’s information in the newly created box. 

In the organization chart presented in Figure 83, an Assistant – Susie Jones – has been added 
to George Washington’s organization. 
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Figure 83 - Organization Chart with Additional Assistant Added 
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